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Ex No: 1              Date:04/06/2022 

a. Starting a program, running a program 
b. Running multiple programs and switching between windows 
c. Running a program from explorer 

 
AIM : Starting a program, running a program 

Procedure: 

Step 1 : Click Start  Button 

Step 2: Type the Application Name in Search Box. Excel  

Step 3: Right-Click on the Excel Application and Click on 

Open file location.  

 

Step 4: Click on the Microsoft Excel 2010 icon then Press Keys  +  (Copy). 

Step 5 : Press Keys Start    +  

Step 6 : In the box type shell:startup  OK  
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Step 7: Open Startup folder Press Keys  +   (Paste.) 

Step 8: Automatically run the Excel program after Restarting Computer. 

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

Output:   
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AIM : Running multiple programs and switching between windows    

Procedure: 

Step 1 : Press Keys Start   +   

Step 2 :  In the box type Mspaint   OK and Calc OK.(Open More Application) 

 

Step 3 : Press key  + . Now you can easily switch from one application to  

another application. 

Step 4 : Press and hold + . A small box reveals all opened programs. 

Step 5 : Release the  key but keep  pressed down; press  until you reach 

the program you want. 

Step 6 : Each time you press , you cycle through the icons representing open 

programs. 

Step 7 : Release the  key. Windows 10 switches to whichever program is 

selected. 

Step 8 : To switch back to the last program that was active, simply press +  

That program becomes the active program once again. 

  



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 5 
 

 

 

Result :  

The program was Executed Successfully and output is verified. 

 

 

Output:   
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AIM : Running a program from explorer 

Procedure: 

Step 1: Press Keys Start   +  (Open Run window)  

Step 2:  In the box type explorer    OK  

 

 

Step 3:  Press Key (Start)   +  My Computer - explorer will be Open. 

Result:  

The program was Executed Successfully and output is verified. 

 

Output:   
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Ex No: 2              Date:07/06/2022 

A. Customizing the Task bar, Making the taskbar wider 

B. Controlling the size of start menu options 

C. Adding a program to the start menu 

AIM : Customizing the Task bar, Making the taskbar wider 

Procedure: 

Step 1: Right-click any empty area of the taskbar and click “Taskbar Settings” to 

change taskbar settings. 

 

 
Change Customizing the Task bar 

 
Step 2: Lock the taskbar  OFF / ON 

Step 3: Automatically hide the taskbar in desktop mode OFF / ON 

Step 4: Use small taskbar buttons  OFF / ON 

Step 5: Place your mouse at the top edge of the taskbar and drag to resize it. 
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Making the taskbar wider 
 
Step 6: Taskbar location on Screen Bottom or Left or Top or Right  

 

Result:  

The program was Executed Successfully and output is verified. 

 

Output:   

Change Task bar Size & location on right side 
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Aim: Controlling the size of start menu options 

Procedure: 

Step 1: Press Keys Start  Button . 

Step 2: Select the top or side border, and then drag to your desired size. 

Step 3: Right-click any empty area of the taskbar and click “Taskbar Settings” to 

change taskbar settings  Personalization   Start, and then turn on Use Start 

full screen. 

 

Step 4: Show app list in Start menu ON/ OFF 

Step 5: Show recently added apps ON/ OFF 

Step 6: Show most used apps ON/ OFF 

Step 7: Show suggestions occasionally in Start ON/ OFF 

Step 8: Use Start full screen ON/ OFF 

Step 9: Show recently opened items in Jump Lists on Start or the taskbar and File 

Explorer Quick Access ON/ OFF 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output:  

Start Menu full screen. 
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AIM : Adding a program to the start menu 

Procedure: 

Step 1: Right-Click any Shortcut Icon on the Desktop  

 

Step 2: Select on pop Menu Pin to Start. 

Step 3: Click Start  Button 

Step 4: See Now Shortcut Icon add on to the start menu 

Step 5: If remove the Icon from Start Menu Right-Click any Shortcut Icon on the start 

menu. 

Step 6:  Select on pop Menu Unpin from Start. 

 

 

Result:  

The program was Executed Successfully and output is verified. 
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Output:  
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Ex No: 3              Date:10/06/2022 

A. Recycle bin, restoring the deleted files 
B. Arranging icons on the Desktop 
C. Creating Shortcuts. Adding a program shortcut in the Desktop 

 
AIM: Recycle bin, restoring the deleted files 

Procedure: 

Deleted files or folders. 

Step 1: Select file the files or folders you want to delete  

Step 2: Press Delete Key and Click Yes.  

Step 3: The files or folders Move to Recycle Bin. 

Step 4: If need Permanent Deleted then Press Shift + Delete Key 

+ and Click Yes.        Note : After Recover Not Possible. 

Restoring files or folders.  

Step 1: Open the Recycle Bin by double-clicking on its icon.  

Step 2: Locate the items that you want to recover. 

Step 3: Check the box next to the files or folders you want to 

retrieve. 

Step 4: Right-click and select restore to recover the items to their original locations. 

Step 5: Select restore all items to restore everything in your recycle bin. 

 

 

Result:  

The program was Executed Successfully and output is verified. 
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Output:  

 

Empty Recycle Bin – All File or Folder Move Source Location 

 

Delete – All File or Folder Deleted to Permanent 
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AIM : Arranging icons on the Desktop 

Procedure: 

Auto Arrange Icons 

Step 1: Press Click Start    + or navigate to the Windows desktop. 

Step 2: Right-click a blank area on the desktop, Select View 

Step 3: View  Auto arrange icons  

 

Sort by Arrange Icons 

Step 4: Right-click a blank area on the desktop, Select Sort by 

Step 5: Arrange icons by Name, Type, Size or Date modified and then click 

Arrange Icons.  

Step 6: Auto Arrange want to arrange the icons on your own, click Auto Arrange to 

remove the check mark. 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

Output:  

Right-click a blank area on the desktop, Select Sort by Arrange icons by Name, 

Type, Size or Date modified and then click Arrange Icons.  
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AIM : Creating Shortcuts. Adding a program shortcut in the Desktop 

Procedure: 

Step  1: Press Click Start   Button.   

Step 2: Browse to the Office program for which you want to create a desktop 

shortcut. 

Step 3: Left-click the name of the program, and drag it onto your desktop. 

Step 4: Shortcut for the program appears on your desktop 

Step 5:  Right-click the program name or File or Folder and then click Send To  

Desktop (Create shortcut). 

Step 6: A shortcut for the program appears on your desktop. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  
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Ex No: 4              Date: 13/06/2022 

A. Creating and removing folders, renaming folders and files 
B. Expanding and collapsing a folder 
C. Sorting a folder 

 
AIM : Creating and removing folders, renaming folders and files 

Procedure: 

Creating New Folder  

Step 1: The fastest way to create a new folder in Windows is with the 

+ + Ctrl+Shift+N shortcut. 

Step 2: Right-click on a blank space in the folder location.  

Step 3: Select New  Folder from the contextual menu. Windows will create the 

new folder at your current location. 

 

Step 4: Enter your desired folder name to replace "New folder" and hit Enter. 

Removing Files or folders 

Step 1: Select file the files or folders you want to delete  

Step 2: Press Delete Key and Click Yes.  

Step 3: The files or folders Move to Recycle Bin. 

Step 4: If need Permanent Deleted then Press Shift + Delete Key 

+ and Click Yes.        Note : After Recover Not Possible. 
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Renaming Folders and Files 

Step 1: Press Click Start    +  Button.   

Step 2: Go to the location where stores your file or folder.  

Step 3: Right click the name of the file or folder you wish to rename. 

 

Step 4: Click Rename (on the menu that opens up).  

Step 5: The fastest way to rename a folder or File Click File and Press Key

Step 6: Type a new name for the file or folder and press  Enter Key. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  
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AIM : Expanding and collapsing a folder 

Procedure: 

Step 1: Press Click Start    +  Button.   

 

Step 2: View Navigation Pane  Show all folders (Click) 

 

Step 3: Click the > (plus symbol) in the folder tree to expand a folder. 
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Step 4: You can also double-click a parent folder in the left or right pane to expand it. 

Step 5: Click the V (minus symbol) in the folder tree to collapse a folder. 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

 Expand One Level  

 Expand Two Levels  

 Expand Three Levels  

 Expand All Levels  

 Collapse All 
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AIM : Sorting a folder 

Procedure: 

Step 1: Press Click Start    +  Button.   

Sort by Arrange folder 

Step 2: Right-click a blank area on the file Explore, Select Sort by 

Step 3: Select an option, such as name, Date, Size, Type, Date modified, and 

Dimensions. 

Step 4: The available options vary depending on the selected folder type. 

 Ascending. Select to sort items in ascending order A-Z. 

 Descending. Select to sort items in descending order Z-A. 

 

Group by Arrange folder 
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Step 1: Right-click a blank area on the file Explore, Select Group by 

Step 2: Select an option, such as Name, Date, Size, Type, Date modified. 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output:  

The File Explore, Select Sort by Arrange icons by Name, Type, Size or Date 

modified click Arrange File and Folder. (Start    +   View Sort  by) 
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Ex No: 5              Date:16/06/2022 

A. Displaying the properties for a file or folder 
B. Using cut and paste operations to move a file 
C. Using copy and paste operations to copy a file 

 
AIM : Displaying the properties for a file or folder 

Procedure: 

Step 1: Press Click Start    +  Button.   

Step 2: To view information about a file or folder, Right-click it and select Properties.  

Step 3: The fastest way to you can also select the file and press key Alt+ Enter. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

 

The file properties window shows you information like the type of file, the size of the 

file, and when you last modified it. , Parent Folder, Free Space, Accessed. 
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AIM : Using cut and paste operations to move a file 

Procedure: 

Step 1: Press Click Start    +  Button.   

Step 2: To cut file or folder Select then Right-click it and select Cut. 

Step 3: The fastest way to you can also select the file and press key +  

 

Step 4: Right-click a blank area on the file Explore, Select Paste. 

Step 5: The fastest way to you can also select the file and press key +  

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

+      +  
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AIM : Using copy and paste operations to copy a file 

Procedure: 

Step 1: Press Click Start    +  Button.   

Step 2: To Copy file or folder Select then Right-click it and select Copy. 

Step 3: The fastest way to you can also select the file and press key +  

 

Step 4: Right-click a blank area on the file Explore, Select Paste. 

Step 5: The fastest way to you can also select the file and press key +  

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

+      +  
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Ex No: 6              Date:19/06/2022 

A. Moving and copying files with mouse 
B. Searching a file or folder by using search command 
C. Recognizing File types using icons 

 
AIM : Moving and copying files with mouse 

Procedure: 

Step 1: Step 1: Press Click Start    +  Button.   

Step 2: To Copy file or folder Select then left-click and HOLD. (Copy) 

Step 3: You release the left mouse button the file will be moved to the new location where 

you released the mouse button. (Paste) 

Step 4: To Copy file or folder Select then Right-click and HOLD. 

Step 5: Select copy here then new location move here 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Select File or Folder Right Click Mouse Select Copy new location Right Click 

Mouse Select Paste. 
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AIM : Searching a file or folder by using search command 

Procedure: 

Step 1: Press Click Start  +  Button.  

Step 2 : Select Search Local Drive Like C:\  D:\ E:\ This PC to look in all devices or Folder  

 

Step 3: Right Corner show Search Quick access  

Step 4: Enter Search Key word “COA” after Press Enter or Click  

 

Output: 
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Aim : Recognizing File types using icons 

Procedure: 

Step 1: Press Click Start    +  Button.   

Sort by Arrange Icons 

Step 2: Right-click a blank area on the file Explore, Select Sort by 

Step 3: Select an option, such as name, Date, Size, Type, Date modified, and 

Dimensions. 

Step 4: The available options vary depending on the selected folder type. 

 Ascending. Select to sort items in ascending order A-Z. 

 Descending. Select to sort items in descending order Z-A. 

 

Group by Arrange icons 
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Step 1: Right-click a blank area on the file Explore, Select Group by 

Step 2: Select an option, such as Name, Date, Size, Type, Date modified. 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output:  

The File Explore, Select Group by Arrange icons by Name, Type, Size or Date 

modified click Arrange Icons. (Start    +    View Group by) 
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Ex No: 7              Date:22/06/2022 

A. Recording and saving an audio file 
B. Connecting a printer to the PC 
C. Capturing and saving entire monitor screen & active program window as 

images 
 

AIM :  Recording and saving an audio file 

Procedure: 

Step 1: Press Click Start     Button 

Step 2:  Type search bar in the bottom-left corner of the Windows 10 screen 

Step 3:  Type “Voice Recorder” 

Step 4:   Click on “Voice Recorder” 

 

Step 5 : Press key Ctrl + R  Recording will be Start. 

Step 4: Start speaking  

Step 5: Press key Backspace Key Record will be Stop then file will save 

automatically. 
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Result:  

The program was Executed Successfully and output is verified. 

Output:  

Ctrl + R  Recording Start            

Backspace Key  Recording Stop  

Recoding Save Automatically         
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AIM : Connecting a printer to the PC 

Procedure: 

Step 1: Press Click Start     Button 

Step 2:  Type search bar in the bottom-left corner of the Windows 10 screen 

Step 3:  Type “Devices and Printers” 

Step 4:   Click on “Printer & Scanners” 
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Step 5:   Connect Printer to computer and Power ON.  

Step 6:   Click on Add a printer or Scanner 

Step 7: Wait for it to find nearby printers, then choose the one you want to use, and 

select Add device. 

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

 

Output:  
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AIM : Capturing and saving entire monitor screen & active 

program window as images 

Procedure: 

Step 1:  The PRINT SCREEN key is usually located in the upper right corner of your 

keyboard. The key looks similar to the following:  

 
Step 2:  The text you see on your keyboard might be PrtSc, PrtScn, or PrntScrn. The 

other text on the Print Screen key is usually SysRq. 

Copy only the image of the active window 

The active window is the window that you are currently working in. Only one window 

can be active at a time. 

Step 3: Click the window that you want to copy. 

Step 4: Press ALT+PRINT SCREEN. 

Step 5: Paste (CTRL+V) the image into an Office program or other application. 

Copy the entire image on the screen 

Step 6: Open everything you want to copy and position it the way you want. 

Step 7: Press PRINT SCREEN. (If you Used Laptop then Fun or Start + PrtSC) 

Step 8: Paste (CTRL+V) the image into an Office program or other application 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

 Alt + PrtSc – Copy Active window   
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MS OFFICE: MS-WORD  

&  

OPEN OFFICE: WRITER 
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Ex No:8                 Date:25/06/2022 

Preparing a Govt. Order / Official Letter / Business Letter / Circular Letter- 

Covering formatting commands - font size and styles - bold, underline, upper 

case, lower case, superscript, subscript, indenting paragraphs, spacing 

between lines and characters, tab settings etc. 

 

AIM : Preparing a Govt. Order / Official Letter / Business Letter / Circular 

Letter- Covering formatting commands - font size and styles - bold, 

underline, upper case, lower case, superscript, subscript, indenting 

paragraphs, spacing between lines and characters, tab settings etc. 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 

Step 3 :  Type letter and Formatting below 

Step 5:  Press Shortcut Ctrl + D  Show Font Properties. 

Step 6:  Change font size  and styles - bold, underline, upper case, lower 

case, superscript, subscript. 
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Shortcut  

 Font size Change - Ctrl + ] (font size increase) or Ctrl+[ (font size increase) 

 Font Bold – Ctrl +B 

 Font Underline – Ctrl + U 

 Upper Case – Ctrl + Shift + A 

 Capitalize Each Word, select the text and press SHIFT + F3 

 Superscript – Ctrl + Shift + + 

 Subscript - Ctrl + = 

 

Step 7: Go to Home > Change case  . 

Do one of the following: 

 Sentence case. 

 lowercase. 

 UPPERCASE. 

 Capitalize Each Word. 

 Capitalize Each Word and the opposite,  

 cAPITALIZE eACH wORD 
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Step 8:  

Indenting paragraphs, spacing between lines 

 

Step 9:  Press Shortcut Ctrl + D Show Font Properties. 
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Step 10: Need spacing between characters Ctrl + D Show Advanced Properties 

 

Step 11: Line Spacing Shortcut  

 Single Line spaced Ctrl +1 

 Apply 1.5-line spacing to the paragraph. Ctrl+5.  

 Double Line -spaced  Ctrl +2  

 Add or remove space before the paragraph. Ctrl+0 (zero). 

Step 12: Tab Settings. 
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Result:  

The program was Executed Successfully and output is verified. 

Output:  

M. VEERAPANDIYAN, MBA., Telephone : 2688545 
CAD Designer  14 Annala Salai, 
 Puducherry 605 5501. 

 10th May 2022. 

The Collector of Villupuram, 
Villupuram. 

Sir, 

On the Insert tab, the galleries include items that are designed to coordinate 
with the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cover pages, and other document building blocks. When you 
create pictures, charts, or diagrams, they also coordinate with your current document 
look. 

You can easily change the formatting of selected text in the document text by 
choosing a look for the selected text from the Quick Styles gallery on the Home tab. 
You can also format text directly by using the other controls on the Home tab. Most 
controls offer a choice of using the look from the current theme or using a format that 
you specify directly. 

To change the overall look of your document, choose new Theme elements 
on the Page Layout tab. To change the looks available in the Quick Style gallery, use 
the Change Current Quick Style Set command. Both the Themes gallery and the 
Quick Styles gallery provide reset commands so that you can always restore the look 
of your document to the original contained in your current template. 

Yours Faithfully, 

(M. VEERAPANDIYAN) 

Copy to 

The Tahslidar, Villupuram 
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Ex No:9                 Date:28/06/2022 

Preparing a newsletter: To prepare a newsletter with borders, two columns 

text, header and footer and inserting a graphic image and page layout. 

 

AIM : Preparing a newsletter: To prepare a newsletter with borders, two 

columns text, header and footer and inserting a graphic image and page 

layout. 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 

 

Step 3: Enter the  =Rand()  After give one Enter 

Step 4: Select All or Press Ctrl + A 

Step 5: Got to Page Layout (Tab)Columns two 

Step 6: Page Border  Page BorderSelect Style  Select Color  Select Width 

ok 

Step 7: Page Border  Page Border Select Art ok 
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Step 8: Got to Insert (Tab)Picture File Browser OpenSelect Image Insert  

Step 9: Got to Insert (Tab)Header Select Header Model 

Step 10: Got to Insert (Tab)Header Select Footer Model 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

On the Insert tab, the galleries include 

items that are designed to coordinate 

with the overall look of your document. 

You can use these galleries to insert 

tables, headers, footers, lists, cover 

pages, and other document building 

blocks. When you create pictures, 

charts, or diagrams, they also 

coordinate with your current document 

look. 

You can easily change the formatting 

of selected text in the document text 

by choosing a look for the selected text 

from the Quick Styles gallery on the 

Home tab. You can also format text 

directly by using the other controls on 

the Home tab. Most controls offer a 

choice of using the look from the 

current theme or using a format that 

you specify directly. 

To change the overall look of your 

document, choose new Theme 

elements on the Page Layout tab. To  
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Ex No:10                 Date:01/07/2022 

A. Creating and using styles and templates: To create a style and apply 
that style in a document 

B. To create a template for the styles created and assemble the styles for 
the template. 

 

AIM : Creating and using styles and templates: To create a style and apply that 

style in a document 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 

Step 3: Create templates Like Student Data Form Like  

Student Data 

Name  : 

Father Name : 

Age : 

Gender : 

Date of Birth : 

Qualification : 

Address : 

Mobile Number :  

E – Mail : 

Student Signature  
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Step 4: Ctrl + S (Save File)  File Name Student Data Select Save as Type: word 

Template. Note : Don’t Forget File Save Location. 

 

Step 5: Go to Home Menu Click file  Click New New from Exiting  Open 

File already saved Template file Student Data.  

Step 6: Open templates file the Data Form  

 

Step 5: Ctrl + S (Save File)  File Name Student Name Select Save as Type: 

word Document  Save 



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 46 
 

 

Result:  

The program was Executed Successfully and output is verified. 

Output 

Student Data 

Name  : Veerapandiyan M 

Father Name : Markandeyan M 

Age : 17 

Gender : Male 

Date of Birth : 10-05-2004 

Qualification : Hsc 

Address : 59-D, Main Road,  
  Thirukkanur, Pondicherry –501. 

Mobile Number : 9360675707 

E – Mail : ccepdy@gmail.com 

Student Signature  
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AIM : To create a template for the styles created and assemble the styles for 

the template. 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 

Step 3 : Go to Home Menu Right Corner Show Styles Apply Styles  

 

Step 4 : Use Shortcut Key Ctrl + Shift + S 

 

Step 5 : Create New Style or Modify Style Window Will be Open 

If Modify Old Style name then Select Modify or Enter if create New Style then 

creative  
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Step 6 : Change Font Setting like More Setting Font Style, Size, Format, Alignment 

after Click Ok button. 

 

Step 8 : Completed on Create Styles after if need this Style Just Select Font the click 

then Apply Style 

 

Result:  

The program was Executed Successfully and output is verified. 

 

Output 
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Ex No:11         Date:04/07/2022 

Creating and editing the table : 
A. To create a table using table menu 
B. To create a monthly calendar using cell editing operations like inserting, 

joining, deleting, splitting and merging cells 
C. To create a simple statement for math calculations viz. totaling the column. 

 

AIM : To create a table using table menu 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 
Step 3 : Go to Insert Menu  Select Table  Select Insert Table 
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Insert Table 

 

Step 4: Enter the Number of Rows 5 and Columns 5.  ok 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output : 
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AIM : To create a monthly calendar using cell editing operations like inserting, 

joining, deleting, splitting and merging cells 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 

Step 3 : Go to Insert Menu  Select Table  Select Quick Tables 
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Step 4: Click any One Cell the go to Go to Layout cell editing operations like 

inserting, joining, deleting, splitting and merging cells 

.  

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

 

Output : 
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AIM : To create a simple statement for math calculations viz. totaling the column. 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

 
Step 3 : Go to Insert Menu  Select Table  Select Insert Table 
 

 

Insert Table 
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Step 4: Enter the Number of Rows 5 and Columns 7.  ok 

Step 5: Create Table  like as above table  Click Total Cell 

Step 6: The Goto layout Farmula 

 

=sum(left) 

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output: 

Name Tamil English Maths Science 
Social 

Science 
Total 

Veera 89 77 82 85 97 430 

Pooja 87 54 67 87 89 384 
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Ex No:12                    Date:07/07/2022 

Creating numbered lists and bulleted lists: 

A. To create numbered list with different formats (with numbers, alphabets, 
roman letters) 

B. To create a bulleted list with different bullet characters. 

 

AIM : To create numbered list with different formats (with numbers, alphabets, 

roman letters) 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3: Select List of text then  

Step 4: Go to Home Menu  Number with different formats (with numbers, 

alphabets, roman Letters 
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Result:  

The program was Executed Successfully and output is verified. 

 

Output: 

 

Numbers List 

1. VEERA 

2. JANANI 

3. RANI 

4. ASHWIN RAJA 

5. POOJA 

Alphabets List 

A. VEERA 

B. JANANI 

C. RANI 

D. ASHWIN RAJA 

E. POOJA 

Roman Letters List 

I. VEERA 

II. JANANI 

III. RANI 

IV. ASHWIN RAJA 

V. POOJA 
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AIM : To create a bulleted list with different bullet characters. 

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3: Select List of text then  

Step 5: Go to Home Menu  Bullet Library formats (bulleted list with different bullet 

characters.) 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Bulleted List-1 

 VEERA 

 JANANI 

 RANI 

 ASHWIN RAJA 

Bulleted List-2 

 VEERA 

 JANANI 

 RANI 

 ASHWIN RAJA 
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Ex No:13                    Date:10/07/2022 

Printing envelopes and mail merge: 

A. To print envelopes with from addresses and to addresses 

B. To use mail merge facility for sending a circular letter to many persons 

C. To use mail merge facility for printing mailing labels.. 

 

AIM :  To print envelopes with from addresses and to addresses 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3: Go to Mailings Menu  Select Envelopes 
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Step 4: To Enter From Address and To Address 

Step 5: The go Options  Select Envelops Size then click ok  after close. 

Step 5: The go Envelops  Select Add to Document or  Print. 

 

 

 

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 

Envelops 

To. 
Creative Computer Education 
59-D, Fathima Complex, 
Main Road, THirukkanur, 
Puducherry -605 501. 

From. 

Veerapandiyan M 
No.4,Gandhi Nagar, 
Saram, Puducherry – 605 001. 
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AIM : To use mail merge facility for sending a circular letter to many persons 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : Go to Mailings Menu Select Start Mail Merge Select Letter 

 

Step 4 : Go to Mailing Menu Select Start Mail Merge Select Type New List 
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Step 5: Click to Customize Columns  

 

Step 6: Remove All Filed Names Or Use Shortcut Alt+R after Enter Y 

Step 7: Add Filed Names (Name & Place) select Add or Shortcut Alt+ A. 

 

Step 7: After Enter ok  

Step 8: Enter the Data 
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Step 8: Click ok Button  then Save File. 

Step 9: After go to Mailings  Select Insert Merge Field  Select Filed then insert 

Nearby Area. 

 

 

Step 10: After go to Mailing Preview Result   Show Filed Data 

 

Step 11: After go to Mailings Finishing Merge  Edit Individual Documents or 

Printing Documents 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Name  : <Name> 

Place : <place> 
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AIM : To use mail merge facility for printing mailing labels. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : Go to o to Mailings Menu Select Start Mail Merge  labels 

 

 

Step 4 : Select (Label Size 30 per page  ok 

Step 5 : Go to Mailings Menu Select Start Mail Merge Select Type New List 
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Step 6 : Click to Customize Columns  

 

Step 7 : Remove All Filed Names Or Use Shortcut Alt+R after Enter Y 

Step 8 : Add Filed Names (Name & Door No, Street, Place, Post Office and District) 

select Add or Shortcut Alt+ A. 
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Step 9 : After Enter ok  

Step 10 : Enter the Data 

 

Step 11 : Click ok Button then Save File. 

Step 12 : After go to Mailings  Select Insert Merge Field  Select Filed then 

insert Nearby Area. 

 

Step 13: After go to Mailing  Update labels. 
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Step 14: After go to Mailing Preview Result   Show Filed Data 

 

Step 15: After go to Mailing Finishing Merge  Edit Individual Documents or 

Printing Documents 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Veerapandiyan M 
No.4,Gandhi Nagar, 
Saram, Puducherry  

Gooamthi V 
No.4,Gandhi Nagar, 
Saram, Puducherry  

Murgan S 
No.4,Gandhi Nagar, 
Saram, Puducherry –  

Thenmozhi R 
No.4,Gandhi Nagar, 
Saram, Puducherry –  

RANI V 
No.4,Gandhi Nagar, 
Saram, Puducherry 

Rajashwin V 
No.4,Gandhi Nagar, 
Saram, Puducherry  

Pooja  U 
No.4,Gandhi Nagar, 
Saram, Puducherry –  

Jayssri J 
No.4,Gandhi Nagar, 
Saram, Puducherry –  

Ashwin V 
No.4,Gandhi Nagar, 
Saram, Puducherry 

Latha P 
No.4,Gandhi Nagar, 
Saram, Puducherry –  

Malar J 
No.4,Gandhi Nagar, 
Saram, Puducherry
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Ex No:14                        Date:13/07/2022 

Using the special features of word: 

A. To find and replace the text 

B. To spell check and correct. 

C. To generate table of contents for a document 

D. To prepare index for a document. 

 

AIM :  To find and replace the text 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : Go Home Menu Select Replace  (Screen Right Corner) or use Shortcut key 

Ctrl + H  (Replace) 

Step 4 : Enter What Find Text “CCE” 

Step 5 : Enter  Replace Text “CREATIVE COMPUTER DUCATION 

Step 6 : Used Replace button or Replace All   

Result:  

The program was Executed Successfully and output is verified. 

Output: 
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AIM : To spell check and correct. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : Got to review Menu Select Spelling & Grammar Option use Shortcut Key  

  Spelling & Grammar Checking. 

Show Bellow box Select Change  

 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 
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AIM : To generate table of contents for a document 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : First Create any documents like Book and Use Styles Heading1, Heading2, 

Heading 3 and More.. 

On the Insert tab 

On the Insert tab, the galleries include items that are designed to coordinate with the 

overall look of your document. you create pictures, charts, or diagrams, they also 

coordinate with your current document look. 

You can easily change the formatting 

You can easily change the formatting of selected text in the document text by 

choosing a look for the selected text from the Quick Styles gallery on the Home tab. 

You can also format text directly by using the other controls on the Home tab. Most 

controls offer a choice of using the look from the current theme or using a format that 

you specify directly. 

To change the overall look of your document, 

To change the overall look of your document, choose new Theme elements on the 

Page Layout tab. To change the looks available in the Quick Style gallery, use the 

Change Current Quick Style Set command. Both the Themes gallery and the Quick 

Styles gallery provide reset commands so that you can always restore the look of 

your document to the original contained in your current template. 
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Step 4: Go to References Menu  Table of Contents 

 

Step 5: Select Any Format Automatically Create to Table of contents 

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 
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AIM : To prepare index for a document. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : Select the text you’d like to use as an index entry, or just click where you 

want to insert the entry. 

Step 4 : On the References tab, in the Index group, click Mark Entry. 

 

Step 5 : You can edit the text in the Mark Index Entry dialog box.  

. 

Step 6 : Click Mark to mark the index entry. To mark this text everywhere it shows 

up in the document, click Mark All. 

Step 7 : To mark additional index entries, select the text, click in the Mark Index 

Entry dialog box, and then repeat steps 3 and 4. 

Result:  

The program was Executed Successfully and output is verified. 

Output: 
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AIM : Create the index 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : After you mark the entries, you’re ready to insert the index into your 

document. 

Step 4 : Click where you want to add the index. 

Step 5 : On the References tab, in the Index group, click Insert Index. 

 

Step 6 : In the Index dialog box, you can choose the format for text entries, page 

numbers, tabs, and leader characters. 

 

Step 7 : You can change the overall look of the index by choosing from the Formats 

dropdown menu. A preview is displayed in the window to the top left. 
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Step 8 : Click OK.  

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

 

Output: 

 

 { XE "Callisto" \t "See Moons" }. 
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Ex No:15                        Date:16/07/2022 

A. Create an advertisement 

B. Prepare a resume. 

C. Prepare a Corporate Circular letter inviting the share holders to attend 

the Annual Meeting. 

 

AIM :  Create an advertisement 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3 : Launch Microsoft Word. Click the “Insert” tab at the top of the screen. Click 

the “Text Box” button on the ribbon.  

 

Step 4 : Choose the “Draw Text Box” option at the bottom of the drop-down menu. 

When the cursor changes to a plus sign, draw a text box on the Word document.  

Step 5 : Click the border of the text box to bring up the orange. 
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Step 6 : “Text Box Tools” tab at the top of the workspace. On the right side of the 

ribbon below the tab, enter the exact dimensions for the advertisement,  

Step 7 : such as “4” in the “Height” box and “3” in the “Width” box. 

Step 8 : Format Menu Select “Shape Fill” menu on the middle of the ribbon 

Step 9 : Format Menu Select Shape outline color and Width  

 

Step 10 : Go to Insert Menu Select Shapes and Draw the Inside Text Box 

Step 11 : After go to format Menu change background Color and Line Color. 

 

Step 12 : Go to Insert  Clip Art Sear For Computer  Go  Select Images Click 

and Insert on Text Box.  
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Step 13 : Click the “File” tab. Click “Save.” Enter a name for the magazine 

advertisement and click the “Save” button. 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

 

Output: 
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AIM : Prepare a resume. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3: Create Resume used Home Menu & Format Menu and Tab Setting. 

Step 4: used All Shortcut Ctrl+B, Ctrl+I, Ctrl+U, Ctrl+T, Ctrl+M 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

 

Output: 

 

Resume 

Name  : Veerapandiyan M 

Father Name : Markandeyan M 

Age : 17 

Gender : Male 

Date of Birth : 10-05-2004 

Qualification : Hsc 

Address : 59-D, Main Road, Thirukkanur, Pondicherry  

Mobile Number : 9360675707 

E – Mail : ccepdy@gmail.com 

Candidate Signature  
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AIM : Prepare a Corporate Circular letter inviting the share holders to attend 

the Annual Meeting. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type winword  OK  

Step 3: Create Resume used Home Menu & Format Menu and Tab Setting. 

Step 4: used All Shortcut Ctrl+B, Ctrl+I, Ctrl+U, Ctrl+T, Ctrl+M 

Step 3 :  Type letter and Formatting below 

Step 5:  Press Shortcut Ctrl + D  Show Font Properties. 

Step 6:  Change font size  and styles - bold, underline, upper case, lower 

case, superscript, subscript. 

 

Shortcut  

 Font size Change - Ctrl + ] (font size increase) or Ctrl+[ (font size increase) 

 Font Bold – Ctrl +B 

 Font Underline – Ctrl + U 

 Upper Case – Ctrl + Shift + A 

 Capitalize Each Word, select the text and press SHIFT + F3 

 Superscript – Ctrl + Shift + + 

 Subscript - Ctrl + = 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 

CREATIVE COMPUTER EDUCATION 
59D, Fathima Complex, Main Road, 
Thirukkanur, Pondicherry -605 501. 

(+91)9360675707 
Notice of Special Meeting of Shareholders 

To Be Held May 10 2022 
To Shareholders:  

A Special Meeting of Shareholders of CREATIVE COMPUTER EDUCATION 

. will be held on Friday, May 10, 2022 at 10:00 a.m., local time, at the 

company’s offices located at 59D, Main Road, Thirukkanur, Pondicherry -605 501, 

in order to:  

Approve a stock option exchange program under which eligible employees 

would be able to elect to exchange certain outstanding stock options for a lesser 

number of shares of restricted stock. The exchange program is more fully described 

in the proxy statement accompanying this Notice of Special Meeting of 

Shareholders.  

The Board of Directors has fixed the close of business on April 3, 2022 as the 

record date for the meeting. All shareholders of record on that date are entitled to 

notice of and to vote at the meeting.  

 
 

By Order of the Board of Directors 
VEERAPANDIYAN M 
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MS OFFICE: MS-EXCEL 

& 

OPEN OFFICE:  

CALC & MATH 
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Ex No:16                        Date:19/07/2022 

Using formulas and functions: 

A. To prepare a Worksheet showing the monthly sales of a company in 
different branch offices (Showing Total Sales, Average Sales). 

B. Prepare a Statement for preparing Result of 10 students in 5 subjects 
(using formula to get Distinction, I Class, II Class and Fail under Result 
column against each student). 

AIM : To prepare a Worksheet showing the monthly sales of a company in 

different branch offices (Showing Total Sales, Average Sales). 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

 

Step 3 : Create Below Table  

Step 4 :  To find the average Sales : =AVERAGE (B3:E3) Or 

 =AVERAGE(B3,C3,D3,E3) 

Step 5 :  To find the Total Sales  :  =SUM (B3:E3) Or

 =SUM(B3,C3,D3,E3) 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

 

 

 

Output: 
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AIM : Prepare a Statement for preparing Result of 10 students in 5 subjects 

(using formula to get Distinction, I Class, II Class and Fail under Result column 

against each student). 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

 

Step 3 : Create Below Table  

To find the Total Marks  G3  :  =SUM (B3:F3)   

To find the average Mark H3  : =AVERAGE (B3:F3)  

To Find the Result   I3   : =IF(MIN(B3:F3)>=35,"Pass","Fail") 

To find the Class  J3   : 

=IF(AND(I3="Pass",H3>=80),"Distinction",IF(AND(I3="Pass",H3>=60),"I 

Class",IF(AND(I3="Pass",H3>=40),"II Class","Fail"))) 

or 

=IF(AND(MIN(B3:F3)>=35,AVERAGE(B3:F3)>=80),"Distinction",IF(AND(MIN(B3:F3)

>=35,AVERAGE(B3:F3)>=60),"I 

Class",IF(AND(MIN(B3:F3)>=35,AVERAGE(B3:F3)>=40),"II Class","Fail"))) 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 
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Ex No:17                        Date:22/07/2022 

Operating on the sheets: 

Finding, deleting and adding records, formatting columns, row height, 
merging, splitting columns etc. Connecting the Worksheets and enter 
the data. Operating on the sheets: 

AIM : To find the text 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3 : Go Home Menu Select Find (Screen Right Corner) or use Shortcut key  

Ctrl + F 

Step 4 : Enter What Find Text 

Step 5 : Click on Find All button or Find Next 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 
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AIM : Deleting and adding records, formatting columns, row height, merging, 

splitting columns etc. Connecting the Worksheets and enter the data. 

Operating on the sheets 

 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3: Select row or Column Head then press Shortcut Key Ctrl+Shift+ = 

 

Step 4: If need Row or Columns Select any one Option  

Or 

Step 5: Go to Home menu Left Corner Select Insert Cell 

 

Step 6: Delete Row or Column  Press Shortcut Key Ctrl+ - 

Or 

Step 7: Go to Home menu Left Corner Select Delete Cell 
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Step 8: Go to Home many Cell Formatting Option formatting columns, row height, 

merging, 

Step 9: splitting columns etc.  

 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 
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Ex No: 18                        Date:25/07/2022 

Creating a Chart: 

To create a chart for comparing the monthly sales of a company in different 

branch offices. 

 
AIM : To create a chart for comparing the monthly sales of a company in 
different branch offices. 
 
Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3 : To Create Monthly Sales Report  

 

 

 

Step 4 : After Select Entre Full Data  

Step 5 : Go to  Insert Menu Select Column any one Chart Type. 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 

 

 

 

  

0

10000

20000

30000

40000

50000

60000

70000

80000

Pondicherry Chennai Villupuram Tirchy

Mar-22

Jun-22

Sep-22



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 90 
 

Ex No: 19                        Date:28/07/2022 

Using the data consolidate command: 
To use the data consolidate command to calculate the total amount budgeted 
for all departments (wages, travel and entertainment, office supplies and so 
on) or to calculate the average amount budgeted for – say, department office 
expenses. 
 
 
AIM : To use the data consolidate command to calculate the total amount 
budgeted for all departments (wages, travel and entertainment, office supplies 
and so on) or to calculate the average amount budgeted for – say, department 
office expenses. 
 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3 : Create Sheet 3 department wise Expense Amount   

Step 4 : Re Name Sheet HR, HR, Sales, Marketing 

 

 

 

Step 5 : Got to Data Menu Select Consolidate 

Step 6 : Select Function SUM or Average  

Step 7 : To Create New Sheet then Re Name Sheet budgeted. 

Step 8 : Enter the Row & Columns Top Filed Values 

Step 9 : To Add All Sheet Data Reference then Click Ok 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 
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Ex No: 20                        Date:31/07/2022 

Sorting Data, Filtering Data and creation of Pivot tables. 

AIM : Sorting Data 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3 : Goto Data Menu 

 

 

 

Step 4 : Enter the Below Data 

Step 5 : After Select Data then go to Data Menu Select Sort 

 

Step 5 : After Select Data then go to Data Menu Select Sort 
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Step 6 : To Setting Sort by Total or any Data Sort on Value Order by Largest to 

smallest then click ok. 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 

Below List Order By Total 
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AIM : Filtering Data 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3: Create Table Like Below and Select Student List. 

Step 4: Go to Data Menu  Select Filter 

 

Step 5: Select to Class  Distinction 
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Result:  

The program was Executed Successfully and output is verified. 

 

Output: 

Class “Distinction” Student Only Show other data will be hidden. 
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AIM : Creation of Pivot tables 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type EXCEL  OK  

Step 3: Create Table Like Below. 

Step 4: Select the cells you want to create a PivotTable from. 

 

 

Step 5: Click Insert menu PivotTable. 

 

 

 

Step 6: This will create a PivotTable based on an existing table or range. 
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Step 6: Select Data 

 

Step 7: Choose where you want the PivotTable report to be placed. Select New 

Worksheet to place the PivotTable in a new worksheet or Existing Worksheet and 

select where you want the new PivotTable to appear.  

Step 8: Click OK 

Step 9: Create Report Row Labels  
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Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output: 

Report on Department Expense and Items of Expense Net Sum Amount 

 

 

 

  



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 99 
 

 

 

 

MS OFFICE: MS-ACCESS 

OPEN OFFICE: BASE 
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Ex No: 21                        Date:03/08/2022 

Creating Student’s address Database and then list the data on the screen in 

alphabetical order. 

 

AIM : Creating Student’s address Database and then list the data on the screen 

in alphabetical order. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type msaccess  OK  
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Step 3: Blank Database  File Name  Create  

Step 4: Select table Right Click on Mouse  Design View 

 

 

Step 5: Change Table Student Address  

 

Step 6: Click ok button 

Step 7: Create Field Name and Data Type as per Below 

 

Step 8 : After Close the Table 

 

Step 9 : Click on Yes Button 
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Step 10 : To Go to Create Menu Form Click  

 

Step 11 : After Closed Form and Save Form click on Yes Button 

 

 

Step 8 : Enter the Form name then Click ok button 

 

 

Step 9 : After Double on click form “Student Address” 
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Step 10 : Fill Student Address Details Form then Press Tab Key Next Student 

Data after complete Just closed Form. 

 

Step 11 : To Go to Create Report Click Select Name Right Click on 

Mouse Select Sort A to Z  Close Window 
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Step 12 : After Closed Report and Save Report click on Yes Button 

 

 

Step 13 : Enter Report name then Click ok button 

 

Step 14 : After Double on click Report “Student Address” 

Show Report on alphabetical order 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output: 

Report on Department Expense and Items of Expense Net Sum Amount 

 

 

Ctrl + P (Print the Report) 

 

Select Printer then Click ok button 
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Ex No: 22                        Date:06/08/2022 

Performing various queries. 

 

AIM : Performing various queries. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type msaccess  OK  

Various queries 

 Update certain information in a specified group of records using an Update 

Query 

 Append data from one table into another using an Append Query 

 Delete specified records from one or more tables using a Delete Query 

 Create a new database table from specific records held in the database using 

a Make-Table Query 

Step 3 : First Create a Table Below Filed. 

 

 

Step 3 Double Click on Table Enter the Data 
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Step 4 : After closed Table 

Step 5 :Go to Create  Query Design 

 

 

 

Step 6 :Select Table 1 then Click Add  
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Append queries 

 

Step 7 : Automatically Open to Design Layout Select Append 

Step 8 : On the Home tab, in the View group, click View, and then click Design 

View. 

Step 9 :  On the Design tab, in the Query Type group, click Append. 

Step 10 : The Append dialog box appears. 

 

Step 11 :  Next, you specify whether to append records to a table in the current 

database, or to a table in a different database. 

Do one of the following: 

Step 12 : In the Append dialog box, click Current Database, select the destination 

table from the Table Name combo box, and then click OK. 

-or- 

Step 13 : In the Append dialog box, click Another Database. 

Step 14 : In the File Name box, enter the location and name of the destination 

database. 
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Step 15 : In the Table Name combo box, enter the name of the destination table, 

and then click OK. 

Select Append Table name  ok 

 

 

Step 16 : Select All Filed  then Drag Drop Below List 

 

 

Step 17 : Click Run Append Table1 to Table2 
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Update queries  

 

Step 1 : Select Update to Right Click – Select Build 

 

Step 2 : Select Database File Name  Select Table  
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Step 3 : Click Run Update Table1 Total and Average 

 

Delete queries 

 

 

Step 1 : Delete Table1 Where StdentName =’veera” 

Step 2 Run Query Delete Student Name Deleted “Veera” 

 

 

Result:  

The program was Executed Successfully and output is verified. 

 

Output: 
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Ex No: 23                          Date:09/08/2022 

Generating Query in Access 

 

AIM : Generating Query in Access 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type msaccess  OK  

 

Various queries 

 Update certain information in a specified group of records using an Update 

Query 

 Append data from one table into another using an Append Query 

 Delete specified records from one or more tables using a Delete Query 

 Create a new database table from specific records held in the database using 

a Make-Table Query 

Step 3 : First Create a Table Below Filed. 
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Step 4 : Double Click on Table Enter the Data 

 

Step 5 : After closed Table 

Step 6 : Go to Create  Query Design 

 

 

 

Step 7 :Select Table 1 then Click Add  
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Step 7 : Drag and Drop Select Field.  

 

 

 

Step 8 :  Run Query Report Student Name and Total 

 

Result:  

The program was Executed Successfully and output is verified. 

 

Output: 
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Ex No.24        Date :12/08/2022 

Generating the Report from Database 

AIM : Generating the Report from Database 

 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type msaccess  OK. 

 

 

 

 

Step 3 : Blank Database  File Name  Create  
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Step 4 : Select table Right Click on Mouse  Design View 

 

Step 5 : Change Table Student Address  

 

Step 6 : Click ok button 

 

 

 

Step 7 : After Close the Table 

 

Step 8 : Click on Yes Button 
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Step 9 : To Go to Create Menu Form Click  

 

Step 10 : After Closed Form and Save Form click on Yes Button 

 

Step 11 : Enter the Form then Click ok button 

 

 

Step 12 : After Double on click form “Student Address” 
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Step 13 : Fill Student Address Details Form then Press Tab Key Next Student 

Data after complete Just closed Form. 

 

Step 14 :Go to Create  Menu Report 

 

 

 

Step 15 : After Closed Report and Save Report click on Yes Button 

 

Step 16 : Enter Report name then Click ok button 



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 119 
 

 

Step 17 : After Double on click Report “Student Address” 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

 

Ctrl + P (Print the Report) 

 

Select Printer then Click ok button 
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Ex.No. 25        Date :15/08/2022 

Importing and exporting data. 

AIM : Importing and exporting data. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type msaccess  OK  

Step 3 : First Create a Table Below Filed. 

 

Step 4 Double Click on Table Enter the Data 

 

Step 5 : After closed Table 

Step 6 :Right Click on Table Export  Excel 
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Step 7 : File name and File Save location Select after click OK Button 

 

Step 7 : File Export Excel Format Successfully after click Close Button 

Step 8 : Next Open File Save Location 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output: 

Data Export to Excel 
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Import 

Step 1 :Right Click on Table Import Excel 

 

Step 2 : See File Name Save Location  ok  

 

Step 3 : Next 
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Step 4 : Finish 
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Step 6 : Close 

 

Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 

Excel file import from Ms Access see Table -3 
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MS OFFICE:  

MS-POWER POINT  

&  

OPEN OFFICE: IMPRESS 
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Ex. No :26        Date :18/08/2022 

Creating a new Presentation based on a template – using Auto content wizard, 

design template and Plain blank presentation. 

 

AIM : Creating a new Presentation based on a template – using Auto content 

wizard, design template and Plain blank presentation. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type POWERPNT  OK  

 

Step 3 : Go to File  New  Sample Template Contemporay photo Album 

(Doblue Cilck File name) 
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Step 4 : Go to Home Menu  New Slide Select Layout. 

Step 5 : Go to Desgin Menu   All Themes Select any one Template 
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Result:  

The program was Executed Successfully and output is verified. 

 

 

Output: 
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Ex. No :27        Date :21/08/2022 

Creating a Presentation with Slide Transition – Automatic and Manual with 
different effects.. 
 

AIM : Creating a Presentation with Slide Transition – Automatic and Manual 
with different effects. 
 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type POWERPNT  OK  

 

Step 3 : Go to File  New  Sample Template Contemporay photo Album 

(Doblue Cilck File name) 
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Step 4 : Select Any One Slide go to  Transaction  

 

 

Step 5 : Transaction  Add this Transaction Effect Side Time and Sound 

Step 6 : Apply to All then 

 

Step 7 : Press F5 From Beginning and From Current Slide Shift + F5. 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Press F5 (Function Key) Show Full Screen Power Point Slide Show 
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Ex .No : 28          Date :24/08/2022 

Creating a Presentation applying Custom Animation effects –Applying multiple 

Effects to the same object and changing to a different effect and removing 

effects. 

AIM : Creating a Presentation applying Custom Animation effects –Applying 

multiple Effects to the same object and changing to a different effect and 

removing effects. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type POWERPNT  OK  

 

Step 3 : Go to File  New  Sample Template Contemporay photo Album 

(Doblue Cilck File name) 
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Step 4 : Object or Text Animation Option List 

 

Step 5 : First Select Object or Text then Click Animation Pane 

Step 6 : Set Object or text Animation Effect and Sound, Duration. 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Press F5 (Function Key) Show Full Screen Power Point Slide Show with 

Animation  
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Ex.No : 29        Date :27/08/2022 

Creating and Printing handouts. 

AIM : Creating and Printing handouts. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type POWERPNT  OK  

 

Step 3 : Go to File  New  Sample Template Contemporay photo Album 

(Doblue Cilck File name) 
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Step 4: To print Document Go to File Menu Print or Press Ctrl+ P  

 

Step 5: Handout 

 

Step 6: Click on Full Page Sides Handouts 6 Slides Vertical Maximum 9 Side  
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Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output: 
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INTERNET 

& 

INTRODUCTION TO 

VARIOUS DEVICES AND 

TOOLS 
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Ex.No:30        Date : 30/08/2022 

Searching for a web site / application / text documents viewing and 

downloading 

AIM : Searching for a web site / application / text documents viewing and 

downloading. 

Procedure : 

Step 1 :  To open any browser Firefox  or chrome or Internet explore 

Step 2 :  After enter Address bar Search Engine Website Domain like 

www.google.com, www.yahoo.com , www.Ask.com, www.bing.com 

Or Directly Open Website Command Window. 

Step 1 : Press Keys Start    +  

Step 2 : In the box type www.google.com  OK  
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Step 3: Enter The Key Words Search Box after click Google Search Button 

Step 4: Search keyword tamilnadu govt Application form 

 

Step 5: Click the Website https://www.tn.gov.in  

Step 6: Download Application Department wise Click any one Department  

Example Click BC, MBC & Minorities Welfare Department 

Step 7: Click Application  Form  

Tamil Nadu Wake Board Election Form-I 

Step 8: Ctrl+ P Print Application or Right corner Show download Button Click It. File 

Will Be Download Computer.  

 

 

 

Use Shortcut See Download Files Ctrl+ J – Show all Download Files 

 

 



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 140 
 

Result:  

The program was Executed Successfully and output is verified. 

 

 

 

Output: 
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Ex. No : 31        Date : 02/09/2022 

Create an E-mail account, Retrieving messages from inbox, replying, attaching 

files filtering and forwarding 

AIM : Create an E-mail account, Retrieving messages from inbox, replying, 

attaching files filtering and forwarding. 

Procedure : 

Step 1 : Press Keys Start    +  

Step 2 : In the box type www.google.com  OK  

 

 

Step 3 : Create account For my personal use  then Next 
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Step 4 : Fill Basic Information username and Password then Next 

 



CCE - Creative Computer Education COA Online Coaching Centre More info Visit www.cceindia.in 

 

www.cceindia.in  CCE – Creative Computer Education - COA Online Coaching Centre. Page 143 
 

Step 5: Enter your Mobile Number and  Current E-Mail Id (Optional) then Next 

 

Step 6: Conform Your Mobile Number then SEND OTP After enter Received Your 

Mobile OTP. 

 

Step 7: Enter the OTP then Click Verify  Yes, I'm in Click  I agree 

After Successfully Create Your Gmail Account. 
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Step 8: Your Received Mail Inbox  Click on Subject  right Corner. 

 

 

Step 8: On your computer, go to Gmail. 

Step 9 : At the top left, click Compose. 

Step 10 : In the "To" field, add recipients. You can also add recipients: In the "Cc" 

and "Bcc" fields.  

Step 11: Add a subject. 
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Step 12: Write your message. 

Step 13: Attach any File. 

Step 14: At the bottom of the page, click Send. 

Step 15: Website Top Corner Show Search Box Enter the Keywords Filter Your 

Mail. 

Result:  

The program was Executed Successfully and output is verified. 

Output: 
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Ex .No :32        Date :05/09/2022 

Create Google form to collect data 

AIM : Create Google form to collect data 

Procedure : 

Step 1: Login Your Google Account  www.gmail.com  Enter 

Step 2 : Enter Your Mail –ID then Click Next 

Step 3: Enter Your Email-ID Password ClickNext. 

 

Step 4: Right corner  Show 9 Dots Click it  Forms 
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Step 5: Go to Open Website forms.google.com   

Step 6: Click Blank  or Contact information 

Step 7: A new form will open. 

 

Step 8: Click + Button 

Step 9: Enter the Question after Select Data Type 
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Step 10: Add more Filed and Send Link or mail 

 

Step 11: Add more Filed and Send Link or mail 

 

Step 12: Copy Form Like share to all 
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Result:  

The program was Executed Successfully and output is verified. 

Output: 

Response Report Check it. 
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Ex.No :33        Date :08/09/2022 

Create Google sheet to collect data 

AIM : Create Google sheet to collect data 

 

Step 1: Login Your Google Account  www.gmail.com  Enter 

Step 2 : Enter Your Mail –ID then Click Next 

Step 3: Enter Your Email-ID Password ClickNext. 

 

Step 4: Right corner  Show 9 Dots Click it  Sheets 

 

Step 5: Go to Open Website https://docs.google.com/ 
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Step 6: Left Corner show  Click Select Sheets 

 

Step 7: Open Sheet Enter Columns Header 

 

Step 8: Save Sheet 
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Step 8: Send Link mail  Copy Form Like share to all 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Response Report Check it. 
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Ex No. 34              Date:11/09/2022 
 
Scan a photo using scanner and edit it using tools available in operating 
system by default. 
 
AIM :  Scan a photo using scanner and edit it using tools available in operating 
system by default. 
 
Procedure: 

Step 1 : Click Start  Button 

Step 2: Type the Application Name in Search Box. fax and Scan 

 
 
 
Step 3: Click on Windows fax and scan 
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Step 4: Click on New Scan (Left Corner) 

 

Step 5: Click on the Preview then you can see Scan Bed Image. 

Step 6: Click on the Scan then Image Saved in Computer (Scan Folder). 

Step 7: Start + E  Documents  Scanned DocumentsScan Image File Saved  
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Step 8: Right -Click on the Image File Open with Microsoft Office 2010 or 

Windows Picture Manager. 

 

 

Step 9: On the Formatting toolbar, click Edit Pictures.  

Step 10: Right Side Show Picture Editing Tools 

 

Step 11: In the Edit Pictures task pane, under Edit using these tools, click 

Crop.  
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 Auto Correct  : Correct color and brightness.  

 Brightness and Contrast  : Adjust the difference between light and dark 

tones. 

 Color : Adjust the hue and saturation.  

 Crop :  Crop out unwanted parts of a picture.  

 Rotate and Flip :  Rotate pictures or flip them on the axis of the picture.  

 Red Eye Removal  : Remove the red from your picture subjects' eyes 

caused by the camera flash.  

 Resize : Change the dimensions of a picture.  

 Compress Pictures : Reduce image file size for various formats. 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Windows fax and scan & Microsoft Office 2010 or Windows Picture Manager. 

 


